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1. ਪੰਜਾਬੀ ਵ ਿੱ ਚ ਵ ੰਨੀ ਪਰ ਾਰ ਦੇ ਵ ੰਗ ਹਨ। 

(a) ਇਿੱ    (b) ਵ ੰਨ   (c) ਦੋ   (d) ਚਾਰ 

 

2. ਹੇਠ ਵ ਵਿਆ ਵ ਿੱ ਚੋਂ ਵ ਹੜੀ  ਾਰ  ਦੀ ਵ ਸਮ ਨਹੀਂ ਹੈ। 

(a)  ਰ ਾ  ਾਰ   (b)  ਰਨ  ਾਰ   (c)  ਰਮ  ਾਰ   (d) ਅਸੰਬੰਧ  ਾਰ  

 

3. ਅਸੀਂ  ਿੱ ਹ ਮੇ ੇ ਜਾ ਾਂਗ ੇ ਾ  ਵ ਿੱ ਚੋਂ ਪੜਨਾ   ਿੱ ਭੋ। 

(a)  ਿੱ ਹ   (b) ਮੇ ੇ   (c) ਅਸੀਂ   (d) ਜਾ ਾਂਗ ੇ

 

4. ‘ਅਪਸ਼ਬਦ’ ਸ਼ਬਦ ਵ ਿੱ ਚ ਵ ਹੜਾ ਅਗੇ ਰ ਹੈ। 

(a) ਅਪ   (b) ਅ   (c) ਅਪਸ  (d) ਆ 

 

5.  ੰਨਾਂ ਨ ੰ  ਹਿੱਥ   ਾਉਣਾ ਮੁਹਾ ਰੇ ਦੇ ਠੀ  ਅਰਥ ਦੀ ਚੌਣ  ਰੋ। 

(a) ਮੁਆਫੀ ਮੰਗਣਾ     (b) ਬਿੱਸ  ਰਾ ਦੇਣੀ 
(c) ਗੁਿੱ ਸੇ ਹੋਣਾ     (d)  ੰਨ  ਮ ਾਉਣਾ 
 

6. ਹੇਠ ਵ ਵਿਆ ਵ ਿੱ ਚੋਂ ਸੁ਼ਿੱ ਧ ਸ਼ਬਦ ਦੀ ਚੋਣ  ਰੋ। 

(a) ਸੁਭ   (b) ਸੁ਼ਭ   (c) ਸੁ਼ਿੱ ਭ   (d) ਸੁ਼ਿੱ ਭ 

 

7. ਦੁਪਵਹਰਾ ਸ਼ਬਦ ਵ ਿੱ ਚ ਵ ਸ ਵਪਛੇ ਰ ਦੀ  ਰ ੋਂ ਹੋਈ ਹੈ। 

(a) ਵਹਰਾ  (b) ਰਾ   (c) ਅਵਹਰਾ  (d) ਵਹਰ 

 

8. ਅ ਰਮ  ਵ ਵਰਆ  ੋਂ ਵ  ਭਾ  ਹੈ। 

(a)  ਰਮ ਸਵਹ   (b)  ਰਮ ਰਵਹ   (c)  ਰ ਾ ਸਵਹ   (d)  ਰ ਾ ਰਵਹ  

 

9. ਪੰਜਾਬੀ ਵ ਿੱ ਚ ਹ ਾ ਦਾ ਬਹੁ ਚਨ  ੀ ਹੋ ੇਗਾ। 

(a) ਹ ਾਏ  (b) ਹ ਾ ਾਂ  (c) ਹ ਾਈ  (d) ਹਨੇਰੀਆਂ 

 

10. ਉ ਟੀ  ਾੜ ਿੇ  ਨ ੰ  ਿਾ ੇ  ਾ   ੀ ਹੈ। 

(a) ਮੁਹਾ ਰਾ  (b) ਵ ਵਰਆ ਵ ਸੇ਼ਸ਼ਣ (c) ਅਿਾਣ  (d)  ਾਰ  
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11. ਨਾਵਸ  ਾ ਨ ੰ  ਪਰਗਟ  ਰਨ  ਈ  ਰ  ੇਜਾਂਦ ੇਸਹੀ ਵਚੰਨ ਦੀ ਚੋਣ  ਰੋ। 

(a) ਵਬੰਦੀ  (b) ਅਿੱਧ   (c) ਵਸਹਾਰੀ  (d) ਮੁ  ਾ 
 

12. ਵਦਨ ਦਾ ਸਮਾਨਾਰਥੀ ਸ਼ਬਦ ਹੈ। 

(a) ਰਾ    (b) ਹਨੇਰ  (c) ਸ਼ਾਮ   (d) ਸ ੇਰ 

 

13. ਬਣ ਰ ਦੇ ਆਧਾਰ  ੇ  ਾ  ਵ ੰਨੀ ਵ ਸਮ ਦੇ ਹਨ। 

(a) ਇਿੱ    (b) ਦੋ   (c) ਵ ੰਨ   (d) ਪੰਜ 

 

14. ਹੇਠਾਂ ਵ ਿੇ ਬਹੁ  ੇਸ਼ਬਦਾਂ ਦੀ ਥਾਂ ਇਿੱ  ਸ਼ਬਦ ਦੋ ਚੌਣ  ਰੋ - 

ਵਜਹੜਾ ਚੰਗੇ ਆਚਰਣ  ਾ ਾਂ ਹੋ ੇ। 

(a) ਦੁਰਾਚਾਰੀ  (b) ਰਾਸ਼ਟਰ ਾਦੀ (c) ਸਦਾਚਾਰੀ  (d)  ੋ ਾਚਾਰੀ 
 

15. ਨਾਂ  ਵ ੰਨੀ ਵ ਸਮ ਦੇ ਹੰੁਦੇ ਹਨ? 

(a) ਚਾਰ   (b) ਵ ੰਨ   (c) ਪੰਜ    (d) ਛੇ 

 
16. 10 persons at a party shake hands once with everyone else in the room. How 
handshakes took place ? 
(a) 66   (b) 64   (c) 45    (d) None of the above 
 
17. Which of the following body is responsible for promoting hockey in India at present ? 
(a) Hockey India     (b) Indian Hockey Federation 
(c) Federation of Hockey in India  (d) Indian Hockey Promotion Federation 
 
18. What is the name of the technology on which cryptocurrency is based ? 
(a) Blockchain technology   (b) Robotic process automation 
(c) Machine learning    (d) Internet of Things 
 
19. Current population of a town is 50000. It is growing at the rate of 5% in first year 4% in 
second year and 2% in third year. The population at the end of third year is ______ 
(a) 55500  (b) 55692  (c) 54600  (d) 54692 
 
20. CAPSTONE a satellite which was in news recently is launched by  
(a) ISRO  (b) NASA  (c) Roscosmos  (d) CNES/CNES 
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21. Which part of the body is most affected by Mercury ? 
(a) Brain  (b) Lungs  (c) Nervous System (d) Liver 
 
22. Which country won the FIEA World Cup 2018 held in Russia ? 
(a) Croatia  (b) Brazil  (c) Germany   (d) France 
 
23. UIDAI has launched a new mobile pp named ____ which performs face authentication ? 
(a) Face Recognition    (b) Face identifier 
(c) Aadhaar FaceRd     (d) Aadhaar Face Recognition 
 
24. What is the theme IWA World Water Congress and Exhibition 2022 ? 
(a) Water for smart liveable cities  (b) Water for planet 
(c) Water for cities    (d) Water for all 
 
25. If Y = 50 and WATER = 134, then DAD will be equal to ______. 
(a) 18   (b) 99   (c) 9   (d) 6 
 
26. Which of the following is not a literary composition by Kalidasa? 
(a) Meghaduta    (b) The Raghuvan 
(c) Abhijnanashakuntala   (d) Panchvati 
 
27. Oriental Bank of Commerce has been merged with which bank? 
(a) Bank of Baroda    (b) State Bank of India 
(c) Indian Bank    (d)Punjab National Bank 
 
28.Who among the following led the Bardoli Satyagraha in Gujarat? 
(a) Sardar Vallabhbhai Patel   (b) Mahatma Gandhi 
(c) Jawahar Lal Nehru    (d) Gopal Krishan Gokhale 
 
29. A merchant has 1000 kg of sugar part of which he sells profit of 9% and rest of the sugar 
he sells at 19% profit. His overall gain is 15%. The quantity sold at 9% profit is _______ 
(a) 600 kg  (b) 400 kg  (c) 560 kg  (d) 640 kg 
 
30. First Lithium cell manufacturing plant of India shall be developed at: 
(a) Tirupati, Andhra Pradesh   (b) Chennai, Tamil Nadu 
(c) Vapi, Gujarat    (d) Boisar, Maharashtra 
 
31. Quit India Movement was launched in response to: 
(a) Cabinet Mission Plan   (b) Cripps Proposals  
(c) Simon Commission Report   (d) Wavell Plan 
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32. Who started the Manji system in Sikhism? 
(a) Guru Nanak Dev     (b) Guru Angad Dev  
(c) Guru Amar Das     (d) Guru Gobind Singh  
 
33. Choose the word within the group that is the least similar to the others. 
(a) Duck  (b) Swan  (c) Goose  (d) Parrot 
 
34. Where is central Sikh museum located? 
(a) Kapurthala  (b) Ferozepur  (c) Jalandhar  (d) Amritsar 
 
35. Hypoglycemin and hyperglycaemia are related to which among the following :  
(a) Blood Sugar (b) Body Fat  (c) Respiration  (d) Thyroid 
 
36. Computer keyboard shortcut which is used to change case is 
(a) Ctrl+F3  (b) Shift+F3  (c) Alt+F3  (d) Ctrl+Shift+F3 
 
37. When was Punjabi Suba originated? 
(a) 1 November 1965    (b) 1 November 1966 
(c) 1 November 1968    (d) 1 November 1967 
 
38. Which is the state bird of Punjab? 
(a) Pigeon  (b) Falcon  (c) Peacock  (d) Sparrow 
 
39. What was the name of the father of Dalip Singh, the last Sikh king of Punjab? 
(a) Charat Singh    (b) Maharaja Ranjit Singh 
(c) Buddha Singh     (d) Sardar Maha Singh  
 
40. Which of the following divisions is not a part of the Punjab administrative division ?  
(a) Faridkot Division    (b) Fazilka Division 
(c) Ferozepur Division    (d) Ropar Division 
 
41. Which of the following is the correct order of the four major functions of a computer? 
(a) Process, Output, Input, Storage  (b) Input, Output, Process, Storage 
(c) Process, Storage, Input, Output   (d) Input, Process, Output, Storage 
 
42. When was the foundation of the British Empire laid in Punjab? 
(a) 1849  (b) 1857  (c) 1882  (d) 1850 
 
43. At which place in Punjab 'Roshnian Da Thiuhar' is celebrated? 
(a) Ludhiana  (b) Jagraon  (c) Jarag  (d) Malerkotla 
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44. Which of the following is capable of recognizing a pre-specified type of mark by pencil or 
pen ? 
(a) OMR   (b) Winchester (c) Bar code reader  (d) Image Scanner 
 
 
45. In a computer spreadsheet, cell range A3 through G3 should be keyed in as ________ 
(a) A3-G3   (b) A3:G3  (c) A3?.G3  (d) A3 to G3 
 
46. Who is considered to be the first poet of Punjabi language? 
(a) Baba Bulleh Shah    (b) Guru Angad Dev  
(c) Waris Shah     (d) Baba Farid 
 
47.What was the old name of Bathinda? 
(a) Bikramgarh  (b) Ramgarh  (c) Phul  (d) Bahia Fort 
  
48.Which is the main source of irrigation in Punjab state? 
(a) River  (b) Canal  (c) Rain  (d) Tubewell 
 
49. VLOOKUP function _______ 
(a) Finds related records    (b) Looks up text that contain “v”  
(c) Check if two cells are identical  (d) None of above  
 
50. The Anglo-Sikh War was fought between:  
(a) Between the British and the Sikhs  (b) Between the British and the Muslims  
(c) Between Sikhs and Muslims  (d) Between Sikhs and Rajput kings 
 
51. Which of the following movements is not a part of Gurdwara reform movement? 
(a) Saka Nankana Sahib   (b) Jaiton Da Morcha 
(c) Naamdhari Movement   (d) Guru Ka Bagh Da Morcha 
 
52.Which of the following is a correct format of Email address? 
(a) name@website@info   (b) name@website.info 
(c) www.nameofebsite.com   (d) name.website.com 
 
53. An attempt to harm, damage or cause threat to a system or network is broadly termed 
as 
(a) Cyber-crime (b) Cyber Attack (c) System hijacking (d) Digital crime 
 
54. Who was the pioneer of Vardhan period? 
(a) Harsh Vardhan (b) Pushyabhuti (c) Pushyamitra (d) Kanishka 
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55. Before declaration as District Fazilka was part of 
(a) Abohar     (b) Shri Muktsar Sahib 
(c) Ferozepur     (d) Bathinda 
 
56. Who is called Manchester of Punjab? 
(a) Chandigarh  (b) Bathinda  (c) Ludhiana  (d) Gurdaspur 
 
57.The festival of Jarag is held in honour of which goddess? 
(a) Sitala Mata  (b) Vaishno Mata (c) Kali Mata  (d) Mother Lakshmi 
 
58. Which Guru Sahib compiled Sri Guru Granth Sahib? 
(a) Guru Harkrishna Ji    (b) Guru Ram Das Ji 
(c) Guru Angad Dev Ji    (d) Guru Arjan Dev Ji 
 
59. Bani of how many Gurus is included in Guru Granth Sahib? 
(a) 06   (b) 09   (c) 10   (d) 13 
 
60. Small text files that websites put on your computer to store information about you and 
your preferences is known as 
(a) URL   (b) Cookies  (c) Address  (d) Home Page 
 
61.Which of the following method can insert a new slide in current presentation? 
(a) From Design menu choose Page setup  (b) From Insert menu choose New Slide 
(c) From Home menu choose Layout  (d) From Home menu choose reset 
 
62. Zafarnama is written by 
(a) Guru Nanak Dev Ji    (b) Guru Hargobind Ji 
(c) Guru Har Rai Ji    (d) Guru Gobind Singh Ji 
 
63. In a computer spreadsheet, SUM, AVERAGE, MIN and MAX are examples of _______ 
(a) Calculations (b) Formulas  (c) Functions  (d) Relative addressing 
 
64. Whose work or creation is Guru Shabad Ratnakara Mahan Kosh? 
(a) Bhai Veer Singh    (b) Bhai Kahan Singh Nabha  
(c) Dhani Ram Chatrik    (d) Giani Gurdit Singh  
 
65. When was the Khalsa Panth founded ? 
(a) 1697  (b) 1698  (c) 1699  (d) 1666 
 
66. If each side of a square is increased by 30% find the percentage change in the area. 
(a) 56.25  (b) 65   (c) 69   (d) None of the above 
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67. Which country has the maximum forest cover in the world ? 
(a) Canada     (b) Democratic Republic of Congo 
(c) Brazil     (d) Russia 
 
68. The upper house of British Parliament is called 
(a) Senate     (b) House of Lords 
(c) House of Commons   (d) House of representatives 
 
69. Interchange the signs and find the correct solution : 
(a) + and *  (b) + and =  (c) + and /  (d) – and * 
 
70. Which country has won cricket world cup for the maximum number of times ? 
(a) Australia  (b) India  (c) West Indies (d) England 
 
71. Fundamental duties are given in which part of the Indian Constitution? 
(a) Part II(A)   (b) Part IV(A)  (c) Part IV(B)  (d) Part III(B) 
 
72. A cistern is normally filled with water in 8 hours but takes 2 hours longer to fill because 
of a leak in its bottom. If cistern is full, the leak will empty the cistern in _____ 
(a) 10 hours  (b) 6 hours  (c) 40 hours  (d) None of the above 
 
73. In a row full of sitting people when counted, Suresh is 16th from both the ends. 
(a) 16   (b) 32   (c) 31   (d) 30 
 
74. If the cost price of 18 notebooks is equal to selling price of 10 notebooks, the price in 
percentage on cost price is: 
(a) 50%  (b) 80%  (c) 100%  (d) None of the above 
 
75. You are given that a train 'P’ is moving at the speed of 90 km per hour and another train 
‘Q’ is moving at the speed of 60 km per hour in the same direction. If length of faster train is 
500 metres and it crosses the slower train in two minutes. The length of slower train is : 
(a) 500 metres     (b) more than 500 metres 
(c) Less than 500 metres   (d) Cannot be determined 
 
76. Ramesh said to a man "He is the son of a man who is the father of the wife of my 
father”. How is the man related to Ramesh ? 
(a) Father  (b) Son   (c) Uncle  (d) Grandfather 
 
77. Choose the collection of symbols that can be properly adapted to the question. 
8_8_4_255_9 = 10 
(a) ×, −,÷, +  (b) ×,÷, −, +   (c) ×,×, −,÷  (d) ×,×, −, + 
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78. Which city is called the culture hub of Punjab ? 
(a) Anandpur Sahib    (b) Amritsar 
(c) Muktsar     (d) Jalandhar 
 
79. Which of the following cannot be the square of a natural number? 
(a) 30565  (b) 45907  (c) 83786  (d) 34894 
 
80. When did Mahatma Gandhi start the Salt Satyagraha? 
(a) 1929  (b) 1930  (c) 1931  (d) 1932 
 
81. Ram alone can do a piece of work in 12 days. Shyam can do the same work in 16 days. In 
order to complete the work faster, three persons Ram, Shyam and Sita together finished the 
work in 6 days and were paid total amount of Re 6400. How much is the share of Sita on pro 
rata basis ? 
(a) Rs. 1200  (b) Rs. 1000  (c) Rs. 800  (d) Rs. 600 
 
82. Which of the following is exactly divisible by 7, 11, 13 and also 16? 
(a) 16016  (b) 15035  (c) 16026  (d) 15119 
 
83. Who is the Vice Chairperson of Niti Aayog? 
(a) Suman Bery (b) Ashish Chauhan (c) Shaktikanta Das (d) Arvind Panagariya 
 
84. Tomb of Sand, the first novel written in an Indian language which has won the booker 
prize is authored by ________ 
(a) Chetan Bhagat (b) Geetanjali Shree (c) Amrita Pritam (d) Jhumpa Lahiri 
 
85. In speedy bike race, A fast rider wants to move at an amazing speed with a winning the 
race overtakes the rider on 8th position with some time and efforts over rider on 5th 
position. After further more efforts and correct decisions at the correct finally overtakes the 
rider on third position coming very close to winning the race the current position of the 
rider on the race track? 
(a) 1st    (b) 2nd   (c) 3rd   (d) 4th  
 
86. What least number must be subtracted from 23891, so that the remainder is divisible by 
87 ? 
(a) 56    (b) 46   (c) 53   (d) 66 
 
87. A boat sails 20 km of a river towards upstream in 4 hours. How long it will take to cover 
the same distance downstream, if the Speed of current is one-fifth the speed of the boat in 
still water ? 
(a) 4 hours     (b) 2 hours 40 minutes 
(c) 3 hours 20 minutes   (d) 5 hours 
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88. Base of a right-angle triangle is 18 cm and its area is 162 sq cm. Find its height. 
(a) 9 cm  (b) 27 cm  (c) 36 cm  (d) None of the above 
 
89. A rectangular block 9 cm by 12 cm by 15 cm is cut up into an exact number of equal 
cubes. What will be the least possible number of cubes? 
(a) 60   (b) 40   (c) 50   (d) none of the above 
 
90. Who was the person who commanded the British force to fire on the crowd present in 
Jallianwala Bagh ? 
(a) General Dyer    (b) Warren Hastings 
(c) Lord Minto     (d) William Butterworth Bayley 
 
91. A sum of Rs. 4240 is to be divided among A, B and C in such a way that the ratio between 
A and B is 7:6 and ratio between B and C is 9:7 and ratio between A and C is 3:2. The 
share of A is: 
(a) 1442  (b) 2100  (c) 1680  (d) None of the above 
 
92. NIFTY50: India :: Dow Jones: 
(a) United Kingdom    (b) United States of America 
(c) Canada     (d) Germany 
 
93. Dog: Paw::Horse: 
(a) Fast   (b) Paw  (c) Hoof  (d) Tall 
 
94. Which gas is emitted naturally by the soil ? 
(a) Radon  (b) Propane  (c) Methane  (d) Argon 
 
95. 'Namak Ka Daroga’ a famous social story is written by 
(a) Munshi Premchand   (b) Mahadevi Verma 
(c) Harivansh Rai Bachchan   (d) Jaishankar Prasad 
 
96. The oath of office is administered to President of India by ___________ 
(a) Chief Justice of India   (b) Solicitor General of India 
(c) Vice President    (d) Speaker of Lok Sabha 
 
97. 10 years ago, age of Vikram was 13 times the age of Avi. After 10 years ratio of ages of 
Vikram will be 11:23. What is the present age of Vikram ? 
(a) 36   (b) 30   (c) 49   (d) 23 
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98. Find the next number in the sequence of numbers given below: 
2, 4, 12, 48, 240, ? 
(a) 1440  (b) 1024  (c) 0   (d) 480 
 
99. If a solid metal ball with a diameter of 12 cm is melted to convert to a solid cylinder with 
same diameter, the height of the cylinder is: 
(a) 12 cm  (b) 6 cm  (c) 9 cm  (d) 8 cm 
 
100. Average age of A and B is 40 years and similarly, average age of B and C is 42 years an 
average age of A and Cis 44 years. The age of C is: 
(a) 44 years  (b) 45 years  (c) 46 years  (d) 43 years 
 
101. Which country is the winner of Asia Cup 2022 Cricket Tournament ? 
(a) Pakistan  (b) India  (c) Sri Lanka  (d) Bangladesh 
 
102. 38 persons can repair a road in 14 days working 5 hours a day. In how many days will 
20 persons working 7 hours a day can complete the work ? 
(a) 20 days  (b) 19 days  (c) 18 days  (d) Cannot be determined 
 
103. By selling an article for Rs. 3956 a trader incurs loss of 8%, What will the selling price if 
he earns a profit of 6% ? 
(a) Rs. 4558  (b) Rs. 4193  (c) Rs. 3718  (d) None of the above 
 
104. Wo is the new Chief Justice of India ? 
(a) Uday Umesh Lalit    (b) N V Ramana 
(c) Dhananjaya Y Chandrachud  (d) Sharad Arvind Bobde 
 
105. Kuno National Park which has recently been in news is in ______ 
(a) Chhattisgarh (b) Madhya Pradesh (c) Gujarat  (d) Assam 
 
106. Which of the following sentences is not correct ? 
(a) She is five feet tall. 
b) Since l left school, I have been working as typist in this company. 
(c) Are you hearing a noise? 
(d) A hammer is used for driving in nails. 
 
107. Choose the most appropriate meaning of 'Reticule': 
(a) a boy's purse (b) a theft  (c) a lady’s purse (d) sleep 
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108. Choose the correct proverb. 
(a) It ever rains but pours. 
(b) It takes three to make a quarrel. 
(c) Kill not the goose that lay the golden eggs. 
(d) Killing three birds with two stone. 
 
109. Change the following into Passive voice: 
I found him sleeping. 
(a) Sleeping was found by him  (b) I am found sleeping by him 
(c) He was found sleeping by him   (d) He was found sleeping by me. 
 
110. To meet one's waterloo means : 
(a) to meet one's defeat   (b) to meet Napolean 
(c) to get into water    (d) to get one's victory 
 
111. Find out the correct spelling: 
(a) Rheumatic  (b) Rheumetic  (c) Rhumetic  (d) Rhumatic 
 
112. 'Radius' is the singular of : 
(a) Radi  (b) Radee  (c) Radii  (d) Radius 
 
113. Choose the correct word for the blanks. 
He _________ that that he could speak five languages. 
(a) Challenged  (b) Boasted  (c) Suggested  (d) Submitted 
 
114. The antonym of MALIGN is : 
(a) slender  (b) praise  (c) criticize   (d) none of the above 
 
115. Adjective form of word ‘Silk’ is: 
(a) Silken  (b) Silkness  (c) Silkless  (d) Silkful 
 
116. Punctuate the following : 
It is mind after all which does the work of the world said my mother 
a) It is mind after all which does the work of the world, said my mother. 
(b) It is mind, after all which does the work of the world, said my mother. 
(c) It is mind, after all, which does the work of the world, "said my mother” 
(d) "It is mind, after all, which does the work of the world", said my mother. 
 
117. Choose the noun form of the given word: 
‘Choose’ 
(a) Chosen   (b) Choosen  (c) Chesen  (d) Choice 
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118. Change the following into an Indirect statement: 
"Do you hear me?" said Shylock to Antonio. 
(a) Shylock told Antonio that he heard him. 
(b) Shylock asked Antonio if he heard him. 
(c) Shylock asked Antonio whether he hears him. 
(d) None of the above. 
 
119. Fill in the blank with correct option. 
I have no control _____ my temper. 
(a) in   (b) over  (c) at    (d) after 
 
120. Arrange the given parts of the sentence in order to produce a correct sentence: 
P. when a chemical substance 
Q. The food poisoning occurred 
R. in the food preparation 
S. was mistaken for salt and used 
(a) QSRP  (b) QPSR  (c) QPRS  (d) SPQR 
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ANSWER KEYS 

 

Q.No. Ans Q.No. Ans Q.No. Ans Q.No. Ans Q.No. Ans 

1. C 25. A 49. A 73. C 97. A 

2. D 26. D 50. A 74. B 98. A 

3. C 27. D 51. C 75. A 99. D 

4. A 28. A 52. B 76. C 100. C 

5. B 29. B 53. B 77. D 101. C 

6. C 30. A 54. B 78. B 102. B 

7. C 31. B 55. C 79. B 103. A 

8. B 32. C 56. C 80. B 104. C 

9. B 33. D 57. A 81. C 105. B 

10. C 34. D 58. D 82. A 106. C 

11. A 35. A 59. A 83. A 107. C 

12. D 36. B 60. B 84. B 108. C 

13. C 37. B 61. B 85. C 109. D 

14. C 38. B 62. D 86. C 110. A 

15. C 39. B 63. C 87. B 111. A 

16. C 40. B 64. B 88. D 112. C 

17. A 41. D 65. C 89. A 113. B 

18. A 42. A 66. C 90. A 114. B 

19. B 43. B 67. D 91. C 115. A 

20. B 44. A 68. B 92. B 116. D 

21. C 45. B 69. A 93. C 117. D 

22. D 46. D 70. A 94. A,C 118. B 

23. C 47. A 71. B 95. A 119. B 

24. A 48. D 72. C 96. A 120. B 
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